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Overview. 
 This protocol defines procedures for digitizing and cataloguing a physical photographic 
objects for www.photoarchive3d.org     
 

 
 
 
Naming Conventions. 
 
Objects are numbered by physical stamp containing a number and collection identifier 
(“G.L.Mutter”) 
Objects are identified in the databases by a sequentially assigned 6-digit number: 
 ObjNr-XXXXXX 
Each digitized image deposited into the photoarchive is identified by a sequentially assigned 
unique 6-digit negative number in the format: 
 NegNr-XXXXXX 
 
 
Generation of a unique object Identifier. 
 Object IDs are assigned in numerical sequence and tracked in the Red Log, and Object 
database (Obj_Annotation_XXX.xls).  Refer to Red Logbook for next entry.   
 
 GLM series begins with ObjNr-000001 GLM Negatives Begin with NegNr-000001 
 BPF Series begins with  ObjNr-200001 BPF Negatives Begin with NegNr-400001 
 OTH Negatives Begin with NegNr-600001  OTH Object Numbers are assigned by third  
  party 
 
 
 
 

http://www.photoarchive3d.org/
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Copystand Photography. 
 

            
 
Camera: 
 Use Canon EOS 5D MarkII set to capture superfine RAW images 
 Lens: 
  Images up to 8” max dimension Use 100mm Lens   
   Canon EF100mm f/2.8L Macro IS USM 
  Images exceeding 8” max dimension Use 50mm Macro Lens 
   Canon EF 50mm f/2.5 Compact Macro Autofocus Lens 
  Microscopic Detail: 0.5" maximum dimension use 65mm lens 
   Canon MP-E 65mm f/2.8 1-5x 
 This yields 21 MP DNG images (5616 x  3744 pixels) 

 As of 2/9/2011, 13,000 images of 5860 physical objects occupy 256GB 
 Average DNG file size is 20MB (actual is 19.7) per image 
 100 stereos, front and back average 4 GB of file space 

 
Lights: 
 Reflected Lights: Use dual 4400K diffused snail lamps set up equidistant R&L of center. 
 Transmitted Lights:   
  Glass: Use LED Halv 5700  6” x 8” lightbox masked for correct opening 
 Hybrid transmitted/Reflected Lighting (Tissues) 
  Fluorescent PortaTrace Box 
  9Watt natural snail lamps for reflected light 
 
Camera Accessories: 
 90’ Angle viewfinder yields 100% field View 
 Cord exposure release 
 16GB CF Cards (Transcend Compact Flash Card 16gb 600x) 
 
Standards: 
 Reflected:  Focusing 7”card & Color Standards 
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 Transmitted:  Transmitted target with grey x-ray film and kodachrome standard.  
 
 
ObjNr-NegNr Concordance File: Photoarchive3d_meta_XXX.xlsx 
 
file:  Photoarchive3d_meta_245.xlsx 
Worksheet: Shoot 
File format: Excel xlxs 
Thjis file has one unique row for each digital negative and provides shoot date and object 
number for each digital negative.  
 
Shoot date is actual date of photography as it will appear in Photo Exif 
Enter ObjNr in sequence based on logbook 
Enter NegNr starting at next negative based on logbook.   
Save after advancing one version number 
 
 
Object Annotation File: Photoarchive3d_meta_XXX.xlsx 
 
File: Obj_Annotation_XXX.xls 
Worksheet: Obj 
File format: Excel xlxs 
This file has one row for each unique object (ObjNr), and does not cross reference negative 
numbers 
 
Directory Structure for Storage: 
 
Directories:  
 Systematic_DNG  
  > GLM_DNG_Vault       Starts with Bin20GB_0001 
  > BPF_DNG_Vault  Starts with Bin20GB_1001 
 Adobe DNG files will be stored in 20GB subfolders designated: “Bin20GB_XXX” 
 Each bin will hold approximately 900 DNG files 
 
Image File Size: 
 Each 21 MP DNG image (5616 x  3744 pixels) files will be saved 
  As of 11/11/2014, 65,803 images of 29,957 physical objects occupy 1,355GB 

 Average DNG file size is 20.6 MB per image 
 
 100 stereos, front and back average 4 GB of file space 
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Importing Metadata into Lightroom from Excel Database 
 
This is done from an excel exported .csv file (MS-DOS format) using the Lightroom Plug-In 
LR/Transporter. 
 
 
Lightroom Transporter: available from  
http://www.photographers-toolbox.com 
 
In excel, prepare a comma delimited file with relevant fields.   

Label fields as first row of column 
Do not use formulas.  Copy and save as values if necessary 
csv File format: 
 

ObjNr NegNr 
ObjNr-007461 NegNr-016061 
ObjNr-007462 NegNr-016062 
ObjNr-007462 NegNr-016063 
ObjNr-007463 NegNr-016064 
ObjNr-007463 NegNr-016065 

 
Save using “save as” command and naming the file with a .csv suffix (MS-DOS format). 
Generally, only 1000 records (file rows) can be imported at one time when matched 
against all files in the LR database.  
 

 
Open Lightroom and activate LR/Transporther 
 Library>PlugIn Extras>Import Metadata using LR/Transporter 
 
This will open a dialog box.   
Choose csv file to import 

http://www.photographers-toolbox.com/
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Record Mapping:  
Match csv file and LR data elements used to identify unique images 
Usually use “contains” options to accommodate different suffixes and prefixes.   
 
Field Mapping: 
Select Data source fields to write to Lightroom Field.  
example: Data Source “Obj-Nr” overwrites Lightroom “Title” 
 
Next box: Which Images? 
Select “All” 
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Exporting Image Metadata Using LR Transporter 
 
 

1. In Lightroom Library, Select Images to be exported in Lightroom.  This can be after 
various filters are applied. 

 
2. In Left Panel, Select “Export” 

 
3. choose LR/Transporter from the top of the export dialog 
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4. Set Up Export to include metadata only 

 
Check Create Summary File and Add Components (Tokens) wanted, separating by “,” or 
“tab”.  e.g. {width},{height},{exportedName} 
Be sure to add a return at end of single line for one photo 
 

 
 

5. Be Sure to select “Delete exported files after transfer” to delete copied images 
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Pulling Pics from a file list: using LR Transporter 
 
 

 
 
 
 
1. Create an ms-dos text file (txt) in which each line contains one file name.  Not necessary to 

add suffix filetype.   
2. file “NegNr-015436.dng”  is entered in txt file as “NegNr-015436” 
3. Open Lightroom Transporter Module:  

a. Library> 
i. PlugIn Extras 
ii. >Mark Images using LR/Transporter 

4. Adjust settings: 
a. txt file location 
b. database “contains” 
c. in text file “without extension” 
d. “Clear existiong marks” 

5. Press “OK” and wait.  It is pretty fast, and can handle up to about 1000 file requests at a time.  
6. View selected files by using Attribute filter
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WEB PRODUCTION 

 

Image Resizing 
 Maximum dimension for web display is 600pixels (6.25inches at 96dpi) 
 Best Thumb size is 200 pixels 
  

Inserting Frontpage Gallery into Dreamweaver: 
 
Re: How can I place a Lightroom 3 image gallery in a Dreamweaver page?  

You'll need to work in CodeView.  

Copy the relevant code from your image gallery page into your site page.  Adjust paths to 
images & scripts as necessary. 

 Another simpler approach, insert an iframe into your site page. Point the iframe src to your 
gallery.html page.  Adjust iframe height and width to accommodate the size of your gallery 
page. 

http://w3schools.com/html/html_iframe.asp 

Nancy O. 
Alt-Web Design & Publishing 
Web | Graphics | Print | Media  Specialists   
http://alt-web.com/ 
http://twitter.com/altweb 

Syntax for adding an iframe: 
<iframe src="URL"></iframe>  
The URL points to the location of the separate page. 

 
Iframe - Set Height and Width 
The height and width attributes are used to specify the height and width of the iframe. 
The attribute values are specified in pixels by default, but they can also be in percent (like 
"80%"). 
Example 
<iframe src="demo_iframe.htm" width="200" height="200"></iframe> 
 

 
<iframe 
src=file://///KMT19_Databox/media/My%20Webs/Photoarchive3D/Galleries/Gallery_01_Test/ind
ex.html width=1000 height=2000></iframe>  
 
 
 

http://forums.adobe.com/message/3590013#3590013
http://w3schools.com/html/html_iframe.asp
http://alt-web.com/
http://twitter.com/altweb
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FOCUS STACK VIA LIGHTROOM 
 
focus stacking portrays deep objects in focus on various focal planes in one sharp image where 
everything is in focus, essentially mimicking a greater depth of field without any loss of definition. 
 
How to focus stack in Photoshop Lightroom. 
Following the steps below to achieve a beautiful composite photo with seamless tones. 

 
1. Plan ahead for compositing. “I engineer my shoot knowing that I’m going to be compositing 
in post,” Clemetson says. Shoot a series of images from the same angle, and use manual focus 
on different areas as you go. 

 
2. Select your photos in Lightroom. Load files you plan to stack into Lightroom. In the Grid 
view or the Filmstrip in the Library module, select the ones you want to stack. (They must be 
located in the same folder or the same collection.) 

 
3. Choose Photo > Edit in > Open as Layers in Photoshop. The stacked photos will display 
an order number in the upper left corner of their thumbnails, with the top layer being photo 1 and 
so on. 

 
4. Select the layers in the Layers panel. Choose Edit > Auto-Align Layers. Be sure to have 
Auto selected in the Auto-Align Layers dialog before pressing OK.  

 
5. Select all the layers in the group. Choose Edit > Auto-Blend Layers. In the dialog, select 
Stack Images and click OK. Now you have your focus-stacked image shown as a layer mask. 
 
 

Tricks in Using Elevated Platform for depth Focus 
1. Use backlit sheet if shadow removal of vignetted object 

desired.  Blue does not work! 
2. Start with lens zoom at approximate desired object size 
3. Move platform to approximate focus, touching up zoom 

size with lens ring.   
4. Leaving lense zoom fixed, turn platform knob to adjust 

focus as needed.  
5. Shoot color standard for adjustment 
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FILE UPSCALING WITH TOPAZ GIGAPIXEL AI 
https://www.topazlabs.com/ 
 
This allows upscaling of image halves and originals (always pre-anaglyph or alignment overlays) 
with coincident Sharpening, noise reduction, and restoration of detail.   
Preferred to photoshop resizing. 
Open Gigapixel AI and import images to be processed.  These can be batched. 

Scaling Gigapixel AI Enlargements:   for 16:9 4K projection at 3840x2160px 
Generally 2x is sufficient at 21MP capture of most stereocards. 

Gigapixel AI Model: can be adapted to material at hand.  
[Examples] 
 

1. Gigapixel AI Model of Choice:   “HQ” Model 
enlarges picture without introducing “AI-evident” distortion.  
Some pics may benefit from sharpening in advance, but this 
should be done image by image to assess effects of 
sharpening artifact. 

a. Best if source image already processed in Lightroom 
for contrast 

b. Will not introduce textural artifacts. 
c. Works with ALL files, may not be ideal for some that 

require enhancement. 
d. Color Bleed and Face Refinement “OFF” because it 

causes distortion. 
2. “low resolution model” increases resolution while introducing 

some artifictual wispy polygonal effects.   
a. A second choice.  
b. Usually best, especially if the image is sharpened in 

advance. 
c. Gives gentle softening of enlarged detail that can 

improve resolution and increase image size.   
3. “Standard” yields some unpredictable textures that increase 

distortion of film grains.    
a. Assess this at 200% viewing resolution with pre-post 

split screen. 
b. Is optimized for overall visual impression when 

viewing the entire image.   
c. Can work very well with pre-sharpened images. 

  
 

https://www.topazlabs.com/
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Gigapixel Ai 4x Enlargement: Effect Of Pre-Sharpening On Gigapixel of Various  
Resolution Models.   Egyptian tomb wall 
 
Lightroom > Gigapixel AI: “HQ AI Setting” at  4x enlargement.   
Lightroom TIFF > Gigapixel AI 
Primary file exported from lightroom.  

Detail in upper right still fuzzy, but pixeless and undirtorted by wisps or polygons 
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Lightroom > Gigapixel AI: “Standard GP AI Setting” at  4x enlargement.   
Lightroom TIFF > Gigapixel AI 
Primary file exported from lightroom.  
Polygonal boundry distortion is cost of detail enhancement  
Sharp resolution of contrast, but with distortion of polygonal color fields that look like a mosaic 
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Lightroom > Gigapixel AI: “Low Resolution GP AI Setting” at  4x enlargement.   
Lightroom TIFF > Gigapixel AI 
Primary file exported from lightroom.  
Detail in upper right now sharp, but some polygon enhancement 
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Sharpen AI > Gigapixel AI: “Low Resolution GP AI Setting” at  4x enlargement.   
Gigapexel Sharpen AI pre-processed before applying Gigapixel AI.  
Very good edge enhancement with with soft with grain effect     
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Another Example of Gigapixel AI on Russian storefronts 
 
BEST:  Lightroom > Gigapixel AI: “HQ AI Setting” at  4x enlargement.   
Lightroom TIFF > Gigapixel AI 
Primary file exported from lightroom.  
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FAIR:  Lightroom > Gigapixel AI: “Standard GP AI Setting” at  4x enlargement.   
Lightroom TIFF > Gigapixel AI 
Primary file exported from lightroom.  
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GOOD: Lightroom> Gigapixel AI 4x: LOW RESOLUTION setting.  Some evident artifact 
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GOOD-BETTER:  Lightroom> Sharpen AI >Gigapixel AI 4x: LOW RESOLUTION setting.  Pre-
sharpening helps details in the face.  
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Photo Types and Abbreviations. 
 
Abrev Type  
S stereo standard 3 ½” by 7” view 
R size Raumbild size; 6x13 cm 
O size Oversized, generally cabinet 
L format Lantern Slide (3.5 x 4.0 inches) 
CDV,V size Carte de Visite 
F format flat mount 
C format Curved mount 
G format Glass -fullsize 
 format Tinted 
A format Autochrome 
 format Salt Print 
 format Litho or photomechanical 
 format Cabinet Card 
PA format Photo album snaps 
 format Large Format 
T format Tissue 
M format mono 
tin format tintype 
e format ephemera-paper 
dag format daguerreotype 
   
   
   
B series Set (usually boxed) 
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Adobe Lightroom Version 
 
Lightroom 

version Installed Camera Raw  
Version Comments 

2.0 09/29/2008   
2.1 10/23/2008   
2.2 12/23/2008   
2.3 03/12/2009   
2.4 06/24/2009   
2.5 09/15/2009   
2.6 03/03/2010   
2.7 04/23/2010   
3.0 06/10/2010   
3.2 08/31/2010   
3.3 12/07/2010 6.3  

3.4.1 5/24/2011   
4.1 8/1/2012 7.1 Requires win 7 
5.0  5/25/2013 8.1 Requires win 7 
5.2 09/22/2013 8.2  
5.3 02/02.2014 8.3  
5.5 06/20/2014 8.5.0 64 bit 
5.6 8/12/2014 8.6 64 bit 
5.7 11/25/2014 8.7 64 bit 
13.5 09/02/2024 16.5 64bit, Classic 
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Eos 5D MarkII Settings, by Photo Type 
 

Setting Paper Cards 
Reflected 

Glass-Trans 
illuminated 

Tissues-Trans 
illuminated 

Albums 
Reflected 

Dial Setting C1 C2 C3 C1 
f-stop priority F16 F13 F13 F16 

ISO 400 400 200 400 
lights daylight snail LED box flur box+ 9w snail daylight snail 

light temp 4400 4400  4400 

Standards focus target, color 
palette 

focus target,  
x-ray film gray 

focus target,  
x-ray film gray 

focus target,  
x-ray film gray 

Focus manual manual manual auto on, 
evaluative 

metering auto (average) center weighted 
manual 

center weighted 
manual auto (average) 

Exposure Bias 0 0 0, -2/3, -1 1/3 0 
white balance set 4400 4400 4400 4400 

File Format RAW, superfine RAW, superfine RAW, superfine RAW, superfine 
Resolution 21MP, 5616x3744 21MP, 5616x3744 21MP, 5616x3744 21MP, 5616x3744 
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Lightroom Import Settings, by Object Type: New Process (2012) 
 

LR Setting Paper Cards 
Reflected 

Glass-Trans 
illuminated 

Tissues-Trans 
illuminated Autochromes 

Auto Tone OFF OFF OFF OFF 

White Balance Temp 4400 
Tint +5 

Temp 4200 
Tint +2 

Temp 4200 
Tint +2 

Temp 4200 
Tint +2 

Copyright from template from template from template from template 
Lens 

Correction Apply Apply Apply Apply 

Tone 
 

Exposure +0.36 
Contrast +14 
Highlights -36 
Shadows +36 

Whites 0 
Blacks -14 

Exposure +0.71 
Contrast +7 

Highlights -43 
Shadows +43 
Whites +21 
Blacks -7 

Exposure +0.36 
Contrast +0 

Highlights -36 
Shadows +36 

Whites 0 
Blacks -14 

Exposure 0 
Contrast +21 
Highlights 0 
Shadows 0 
Whites 0 

Blacks -29 

Presence 
Clarity +36 

Vibrance +14 
Saturation 0 

Clarity +36 
Vibrance 0 

Saturation 0 

Clarity +50 
Vibrance +14 
Saturation 0 

Clarity +36 
Vibrance +0 
Saturation 0 

Sharpening 
amount 25 
radius 1.0 
detail 25 

masking 0  

amount 25 
radius 1.0 
detail 25 

masking 0  

amount 25 
radius 1.0 
detail 25 

masking 0  

amount 25 
radius 1.0 
detail 25 

masking 0  

Noise 
Reduction 

Luminance 25  
Detail  50 
Contrast 0 
Color 25 
Detail 50 

Luminance 10  
Detail  50 
Contrast 0 
Color 25 
Detail 50 

Luminance 30  
Detail  50 
Contrast 0 
Color 25 
Detail 50 

Luminance 0  
Detail  50 
Contrast 0 
Color 25 
Detail 50 

Profile 
Correction 

Basic 

Enable Profile Corr 
(automatic) 

Remove Chromic 
Aberr 

Enable Profile Corr 
(automatic) 

Remove Chromic 
Aberr 

Enable Profile Corr 
(automatic) 

Remove Chromic 
Aberr 

Enable Profile Corr 
(automatic) 

Remove Chromic 
Aberr 

Format DNG convert DNG convert DNG convert DNG convert 
Rename NegNr-0XXXXX NegNr-0XXXXX NegNr-0XXXXX NegNr-0XXXXX 

 
Noise Reduction (Luminance): Extent varies with type of image 
 Paper views 25 
 Grainy paper 45 
 Glass  0-25 
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Metadata Mapping 
 
LR Seq Category IPTC Field Annot xls Value  
1 LR Core Copy Name    
2 LR Core Rating    
3 LR Core Label    
4 LR Core Caption    
5 IPTC Core Headline    
6 IPTC Core Subject Code    
7 IPTC Core Desc Writer    
8 IPTC Core Category    
9 IPTC Core Other Category    
10 IPTC Image Date Created    
11 IPTC Image Intellectual 

Genre 
   

12 IPTC Image IPTC Scene 
Code 

   

13 IPTC Image Sublocation    
14 IPTC Image City    
15 IPTC Image State/Province    
16 IPTC Image Country    
17 IPTC Image ISO Country 

Code 
   

18 IPTC Workflow Title ObjNr   
19 IPTC Workflow Job Identifier    
20 IPTC Workflow Instructions    
21 IPTC Workflow Creditline    
22 IPTC Workflow Source    
23 IPTC Copyright Status    
24 IPTC Copyright Copyright    
25 IPTC Copyright Rights 

usageterms 
   

26 IPTC Copyright Copyright URL    
27 IPTC Extended Person Shown    
28 IPTC Ex Location 

Created 
Sublocation    

29 IPTC Ex Location 
Created 

City    

30 IPTC Ex Location 
Created 

State/Province    

31 IPTC Ex Location 
Created 

Country    

32 IPTC Ex Location Country Code    
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LR Seq Category IPTC Field Annot xls Value  
Created 

33 IPTC Ex Location 
Created 

World Region    

34 IPTC Ex Location 
Shown 

Name of 
Organization 

   

35 IPTC Ex Location 
Shown 

Code of 
Organization 

   

36 IPTC Ex Location 
Shown 

Event    
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Digital Projection: 
 
Color Balance 
 Always use sRGB for jpgs to be projected directly 
 If in PPT, ok to use sRGB or adobe RGB 
 
 
Anaglyphs: 
 Will ghost if compressed.  Always size and crop full sized TIFF when possible 
 and convert to optimized anaglyph (red/cyan) JPG as the very last step.   
 
Software for Anaglyph manipulation: 
 
Stereophotomaker is the best software for this purpose and it is freeware available at: 
Download and see instructions at 
 
http://stereo.jpn.org/eng/stphmkr/ 
 
 
 
 
 
 

http://stereo.jpn.org/eng/stphmkr/
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Optimized Anaglyph Mode 

Output[R] =(Left[R]x0 + Left[G]x450 + Left[B]x1050+ Right[R]x0 + Right[G]x0 + Right[B]x0 ) / 
1000 
Output[G] =(Left[R]x0 + Left[G]x0 + Left[B]x0 + Right[R]x0 + Right[G]x1000 + Right[B]x0) / 1000 
Output[B] =(Left[R]x0 + Left[G]x0 + Left[B]x0 + Right[R]x0 + Right[G]x0 + Right[B]x1000) / 1000 

In the above example, all of the blue and green information is presented to the right eye but 
none of the left image red color data has been used in deriving the output red channel. 
Instead, 30% of the green channel and 70% of the blue channel are used are both are 
brightened by 50%. 
This would eliminate rivalry caused by the red component of the image but color reproduction is 
obviously not accurate. If subjects with saturated blue or green components are causing 
problems, you could try altering the color mix of the output green and blue channels. 

OPTIONAL: Apply a gamma correction (gamma value 1.5) to brighten up final red channel ra.   
This is the LEFT image in Stereophotomaker.  To do this in the multiple process menu select 
adjust gamma and enter 1.5 for LEFT panel.   
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Red/Cyan Glasses: 
 

American Paper Optics www.3dglassesonline.com 
1x 3D Anaglyph - Red Cyan - 300 at $0.35 each for $105.00 each 

 
 
Projection sizes:  Digital projection*** of jpgs: size depends on projector resolution. 
 
 

 
Digital Projectors: 

Some basic choices for native resolution are the following:  
1. SVGA (800x600) - SVGA projectors are great for those on a tight budget, since prices 

have dropped dramatically in recent years. While most computers still output in higher 
resolution, SVGA can be a good option for Powerpoint presentations or other applications 
that are not heavily dependent on detail. 

2. XGA (1024x768) - XGA projectors have come down in price over the past few years, and 
have become the budget standard. Many laptop computers still output in native XGA, and 
matching an XGA projector to your native XGA laptop ensures you won't lose any detail. 

3. HD (1280x720):  high definition 
4. WXGA (1280x800) - WXGA products are high resolution widescreen products, and 

usually a bit more expensive than XGA. These products are targeted for use with mid-
range widescreen laptops, which often use 1280x800 natively. They are becoming 
increasingly common and are used as an inexpensive widescreen alternative to XGA. 

http://www.3dglassesonline.com/
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5. ***SXGA+ (1400x1050 this is the Canon SX80 MarkII projector native resolution) - 
SXGA+ resolution is useful for detailed photography and data graphics, but overkill for 
text display or Powerpoint presentations. 

6. UXGA (1600x1200) - UXGA is for very high resolution workstation applications that are 
detail or information intensive. These are expensive projectors that support a broad range 
of computer equipment. Relatively few products on the market have this native resolution. 

7. 2K or QHD (2560x1440).  “Quad HD”  
8. 4K or UHD (4096 x 2160):  4K is an emerging standard for 16:9 movies, but most 

projectors in 2024 are of lesser resolution.  Frequently, online “4K” is actually 2K upscaled 
at the source.  

9. 8K or UHD-2 (7680x4320):  This is a not yeat realized deployment for common 
equipment in 2024.   

10. Polarized half width 1920x1080. 
Used by D. Pellerin London Steroscopic.  Prepare 
halves at 1040 height, and save in SPM as side-
by-side 3840 x 1040 pixels.     
PPT graphics can be prepared on a 96dpi layout 
measuring 40" wide x 11" high (this is 3840w x 
1056h) centering the halves at left-10", right-30". 
Save PPT slides as separate tiff files.  
Add 10 pixels to top and bottom in photoshop by 
increasing canvas size to 3840x1080 with black 
edge.Then, resize in photoshop to 1920w x1080h.   
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Images intended for display on 3D DLP TV's should be 1280x720 or 1920x1080 depending 
upon the native resolution of your TV. 
 
Powerpoint onscreen aspect ratio 4:3 width:height 
 
  Std PPT “onscreen” is 10” x 7.5” at 96dpi or 960x720.   
  THIS DOES NOT ALLOW HIGH REZ SAVES.  all will be at 96dpi.   
 
  XGA projector is 1024x768  (PPT 1024x768) 
  XGA PPT is 10.67” x  8” at 96 dpi to get 1024 x 768 
  Do as TIF 
 
  SXGA projector is 1400x1050 (PPT 1440x1080) 
  Closest PPT SXGA is 15” x 11.25” at 96dpi for 1440 x 1080 
  Do as JPG 
 

4K Projectors (Such as the LG HU810P) are 3840x2160 pixels in a 16:9 aspect 
ratio 
For PPT 3840x2160, or 4K is 40” x 22.5”  at 96dpi 
Can save as any format (jpg, tif, png, etc) 
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Powerpoint  Settings (PPTX file) for projection: 
 
 Automatic compression in PPT must be disabled, and output targets set to retain 
resolution.  Otherwise, images will be degraded.  File will save as PPTX. 
 
Slide Master:  Pixel Density and sizes for different projector resolutions.  
 
HD=1440 px wide:   
Best Option  to output High Definition images:   
Page setup is 15” x 11.25”.     
Pixel resolution: 96dpi 
This will perfectly fit a 1440 x 1080 pixel image at 96 dpi withouut resizing. 
Set output at 96dpi 
 
Full 4k (3840x2160px): 
Page Setup is 40.0” x 22.5” 
Pixel resolution: set for high fidelity.  “Prints” at 96dpi 
This will perfectly fit a 3840x2160  pixel image to print at 96 dpi without resizing 
 
Turn off compression 
File>Options>Advanced>Image Size and Quality 
 Check “Do not compress images in File”  
 Set Default Target Output to 96 dpi.  This is good for projection, and will prevent 
compression by the projector 
 
Set Resolution for Projection 
Slide Show>Resolution 
 “Show On”  is hardware selection for projector.  Pick attached projector.   
 Pick highest resolution available 
 
 
Powerpoint Settings for Exporting Slide JPGs 
 
Choose File Format: 
 File>Save as    (usually use tif  as jpg produces compression ghosting in PPT) 
 
Choose Resolution: from “Compress Pictures” dropdown box. 
 Generally select “document resolution” 
 
This will generate a series of TIFFs which can be projected as is, or converted by a program 
such as Adobe Lightroom or Photoshop to a jpg file (NO compresssion, use 100% quality).   
 
JPGs or TIFs can be projected directly as individual files.   
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Embossed Watermark with Lightroom: 
 
 Text:  
 Applied to all online images >300 pixels maximum dimension.  
 © Note that the shortcut for the copyright symbol is 00A9 Unicode Hex.  
 Invoked by shortcut Alt+0169 
 Format: 
 Best to do as translucent embossed text, including © at beginning 
 Matching Color Embossed Text Overlay is exact designation 
 
  
PA3D Watermark for public deployment 
 
Use png template created in Adobe Illustrater, with transparent background. 
Set this as an “image” watermark. 
Watermark used is “PA3D_Flurry” at 30% transparency.  This is deployed with a center anchor 
at 90% proportional to aspect ratio of the image, which resized watermark to each image.   
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Printing of Physical Stereocards.  
 
Using procedures in place at www.civilwarin3d.com 
 
David Richardson. 
 
 
 
 

http://www.civilwarin3d.com/
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September 2024 Update of Equipment for Digitization 
 
 
Equipment currently in use is specified above, but the below lists comparable equipment 
updated as to model as available in 2014 
 
Good Vendors: 
 
Good vendors for Digital Cameras and equipment (has prices): 

http://www.bhphotovideo.com/ 
http://www.calumetphoto.com/ 

 
Computer Materials available at PC Connection: 
 http://www.pcconnection.com 
 
The camera has two models, and either is probably ok.  There is a mark II ($2500) and  Mark III 
($3500).  If you need to reduce budget go for the Mark II. 
 
Digital file storage is a system solution.  Those listed here are guidelines.  You need an IT 
person to review and recommend based on your environment.    But, definitely go for DNG raw 
file format storage.  It is smallest lossless and proactively compatible format available.   
 
Various copystands are available.  Biggest problem is diffusing the light so you do not get 
shadows or hotspots.  I use big reflectors with silver diffuser screens, but if you have a good 
photographer onsite they may have a recommendation.  I do not like halogen point sources, and 
horizontal linear fluorescent DAYLIGHT (4400K) lamps are ok and sometimes available integral 
to copystand.  These are special bulbs.  
 
Item Mfr Mfr# Price Note 
Adobe Lightroom Classic Adobe   Image catalog 

software 
Canon Eos 5D MarkIII, 22.3MP Canon 5260B002 3449 Camera Back 
Canon EF100mm f/2.8L Macro IS USM Canon 3554B002 1050 Closeup Lens 
Canon EF 50mm f/2.5 Compact Macro 
Autofocus Lens 

canon 2537A003 300 Mid dist Lens 

4400K snail fluorescent  lamps in 13” 
dome reflector with diffuser 

several   Budget $400 for lights 

90’ Angle viewfinder Type C Canon 2882A002 
 

199 Calumet#CA4111 

Lightroom Transporter 
http://www.photographers-toolbox.com 

   Metadata importer.  to 
get into lightroom 

B6-533 Numbering Machine, Gothic 6-
wheel 

Reiner B6  About $250 

Remote Switch RS-80N3 Canon 2476A001   

http://www.photographers-toolbox.com/


   Digitization of Stereophotos    www.Photoarchive3D.org 

Page 37 

Item Mfr Mfr# Price Note 
Extra Battery for Canon Eos 5D Mark 
III 

Canon    

Copy Stand such as Beseler CS 
Digital/Photo-Video Copy Stand 

Beseler 4211-02   

Netgear 48TB ReadyNAS Pro 6 
Unified Storage System w 
NAS(enterprise)-Class Hard Drives 

Netgear RN628 
6x8TB 

4K Need 2, back up 
primary to offsite 
second 

Blue-Ray M-Disc Writer, for 23 GB 
discs 

any   M-discs are archival 
metal.  essential 
backup.  

32GB CF Memory cards for Camera Sandisk SDCFXP-
032G-A91 

150 Get minimum of 2 

128 GB USB solid state (“thumb drive) various  300 For file transfers 
ViceVersa File duplication utility from 
http://www.tgrmn.com/ 
 

   Essential to copy big 
files and verify 
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VIRTUAL REALITY CONVERSIONS: 
 

VR Target Dimensions: 4200x1400px 
 

Skybox  
 Aspect Ratios:  4:3, 3:2, 16:9 1440x1080 is 3:2 
 3D Formats:  2D, 3D-Side by Side, 3D-TopBottom 180°, 360° 
 Filetypes: mp4, mkv, avi, mov, wmv, rmvb, flv, 3gp, webm, vob 
 Resolution:  HD, fullHD, 4K 
   The maximum resolution supported is 4096×4096. 
 
 3:2 screen ratio = halves of  3:2  
 SBS ratio is then 6:2, composed of two side by side 3:2 halves 
 Halve dimensions:  2100 wide, 1400 high  
 VR side by side dimensions = 4200wide x 1400 high 
 

SPM Side By Side Settings for VR export: 
 
Typical Resolution of halves is height 1900px-2500px  
 
Set image borders to be small,  
Inner Border (display, and print/save) 5px.  Color = black .  Unclick round 
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Here is how it looks with the settings 
 

 
 
 
 
Side by side output with a 2px border is total of  
 
 Halve dimensions:  2100 wide, 1400 high  

 Check: keep designated size + border 
 Check Save Borders 

 VR side by side dimensions = 4200wide x 1400 high total 
 VR side by side settings as below:  
 
 



   Digitization of Stereophotos    www.Photoarchive3D.org 

Page 40 

 
SPM output options 
To format images for digital projection, after checking the 'Resize' box you will have the option to 
'Keep Aspect-ratio'. (see screenshot at top of page). 
On checking that, you will have the option to crop or to apply a border. 
 
NO 

 
 
YES.  Centered and fits inside 6:2 box of two halves of 3:2 

 
 

http://stereo.jpn.org/eng/stphmkr/help/file_09.htm#top
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Creating a VR movie in Adobe Premiere Pro 
 
Drop 4200wide x 1400 high images into the Media Browser.   
Sort as wished 
Select(all) and drag into the video timeline panel 
With cursor in timeline panel, “select all”.  Images wiil turn pink 
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Export:  File>export>media 
 
Export settings: 
Source Scaling:  Scale to fit 
Format H.264 
Preset: Match Source: high bitrate 
Export video and audio.  
Check “use maximum rener quality.  
Time interpolation = Frame sampling 
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COLORIZATION with AI 
 
Peter Der Manuelian  2021-03-04 
 
     AI colorization is intriguing, but still not completely accurate.   
 Most seem to be having trouble with reds and non-foliage greens, less with humans. 
Shadows falling across a color changed the color entirely(girl on lily pads).  Rarely, the vintage 
tinting (heavy sepia, for example) got in the way and made everything brown on colorization.  
Attached are a few PA3D archive examples.  
    The following examples are an experiment where I took original color images, both film and 
digital, and removed all color information to make a grayscale image.  Then I sent the grayscale 
images to a re-colorization algorithm (deoldify) in 2021.  This allowed comparison of known 
actual source color with color reconstructed by AI.    Results are generally inaccurate, but in 
many cases quite artistically beautiful.  Attached are comparisons of the original-decolorized-
colorized series. 
    It seems that if there are AI-recognizable objects in the image such as humans, water, or 
foliage, it gets those right and has a chance to calibrate against that standard.  I do wonder if 
varying color-sensitivities of vintage emulsions will require process-specific algorithms for 
correction.  I am waiting for next generation +2 or +3 to really get color accuracy right, expecting 
it will require some user controls that are lacking here.  Thats a problem with ai.   
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Recolorized Color Chart.   Note loss of color fidelity with no AI-recognized objects 
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Colorization Errors: 
Left:  Red pointsetta flower coded as green leaves.  AI miscue.  
Right:  Loss of color fidelity with no AI reference points 
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Aesthetic colorization of vintage images.  
 
1.1930’s Verascope glass Caberet backstage 
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2.  Paper stereo half.  Note green fidelity fails in dress shadow and with lighting conditions on 
pads.  
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